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Some B-I-G news this month! Microsoft has recently announced Copilot.  Whilst it’s not yet available 
to most of us (it’s a Copilot that’s not been flighted [Groan – Ed.]), they are intent on building a frenzied clamour of interest for their new Microsoft 
365 service.  We provide details below.

There are plenty of other topics in here too.  We detail things that have rolled out in our Excel and Power BI updates, plus 
have yet another Beat the Boredom Challenge, plus Charts & Dashboards, Visual Basics, Power Pivot Principles, Power Query 
Pointers, more Keyboard Shortcuts and finally, the A to Z of Excel functions actually ploughs through no less than THREE letters 
of the alphabet stopping off to remind us all of the new wunderkind LAMBDA.

As always, happy reading and remember: stay safe, stay happy, stay healthy.
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Emanating from Github Copilot where developers fed back stating 88% felt they were more product, 77% said the tool helped them spend less time 
pounding the internet search engines and 74% stating their work became more satisfying, Microsoft announced Microsoft 365 Copilot in mid-March.  
And it’s certainly whipped up a frenzy…

So what the heck is it?

Copilot combines the power of Large Language Models (LLMs) with data in your Microsoft 365 apps, products and services to convert your words into 
productivity tools – all whilst maintaining the software giant’s existing commitments to data security and privacy in the enterprise.

Need a Copilot?
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It’s integrated into Microsoft 365 in two ways:

	 1.	 It is embedded in the Microsoft 365 apps (e.g. Word, Excel, PowerPoint, Outlook, Teams) to facilitate more creative and productive 	
		  solution, upgrading your skills at the same time

	 2.	 Business Chat: this works across the LLM, the Microsoft 365 apps, and your data (e.g. calendar, emails, chats, documents, meetings,  
		  contacts) to undertake tasks which would have been more complex to coordinate previously, such as “tell my team how we updated the  
		  product strategy” whereby it might generate a status update based on the morning’s meetings, emails and chat threads.

Obviously we don’t have access to it yet, but we summarise Microsoft’s own comments below.

This will work beside end users / modellers to help analyse and explore 
spreadsheet data.  You will be able to ask Copilot questions about your 
data set in natural language, not just formulae, making Excel more 
accessible to all (looks like we might be out of a job then!).  It can detail 

correlations, propose what-if scenarios and suggest formulae based upon 
your questions, identify trends, create visuals, generating models based 
on your questions that help you explore your data without modifying it. 

Microsoft lists the following as viable examples:

	 •	 Give a breakdown of the sales by type and channel, displaying the results in a table

	 •	 Project the impact of a 3% increase in inflation and generate a chart to help visualise

	 •	 Model how a change to the growth rate for staff wages would impact my gross margin.

Copilot in Excel
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Copilot in Word writes, edits, summarises and creates copy as requested.  
With only a brief prompt, it will create a first draft for you, bringing in 
information from across your organisation as needed. Copilot can add 
content to existing documents, summarise text, and rewrite sections 
or the entire document to make it more concise.  You can even get 

suggested tones, from professional to passionate and casual to thankful, 
to help you strike the right note.  Copilot can also help you improve your 
writing with suggestions that strengthen your arguments or smooth 
inconsistencies (maybe it has even learned so spell “liaise”!!). 

Microsoft suggests the following examples:

	 •	 Draft a two-page project proposal based on the data from the Budget Forecast document for 2023 and the Sales Forecast spreadsheet

	 •	 Make the third paragraph more concise

	 •	 Change the tone of the document to be more casual

	 •	 Create a one-page draft based on this rough outline.

Copilot in Word
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Here, Copilot helps you turn your ideas into presentations.  It can 
transform existing written documents into decks complete with speaker 
notes and sources or start a new presentation from a simple prompt 

or outline.  Are we needed anymore!?  Lengthy presentations may be 
condensed at the click of a button and use natural language commands 
to adjust layouts, reformat text and time animations. 

Copilot in PowerPoint

Yet again, here are some suggested examples:	

	 •	 Create a five-slide presentation based on a Word document and include relevant stock photos

	 •	 Consolidate this presentation into a three-slide summary

	 •	 Reformat these three bullets into three columns, each with a picture.
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In Outlook, Copilot can work with your inbox and messages to summarise 
lengthy email threads, respond to emails quickly or wordsmith emails to 
sound more professional, and request a summary of unread emails, send 
out invitations, etc.

In Teams, meetings can be run more effectively, where Copilot can 
summary outstanding action points, summarise previous conversations, 
create meeting agenda and summarise discussions.  

Business Chat is a new experience that works across all your data 
and apps.  As above, it works alongside you, using the power of the 
Microsoft Graph to bring together data from across your documents, 
presentations, email, calendar, notes and contacts.  You may bring 

together information from multiple sources to keep everyone on the 
team on the same page and moving forward together.  As a result, you 
should spend less time focused on the tools and more time focused on 
the most important work. 

It is slowly being rolled out in Preview in Microsoft Teams.

Examples here might include:

	 •	 Summarise the chats, emails and documents about the customer complaint made earlier today

	 •	 What is the next milestone on the Invade Mars project?  Were there any risks identified?  Help me brainstorm a list of some potential 	
		  mitigations

	 •	 Write a new planning overview in the style of the Marketing Guidelines document that contains the planning timeline from the Project 	
		  Xerxes spreadsheet and incorporates the project list in the email from Shania Twain (OK, I have used a little bit of imagination here…).

Copilot in Other Applications

Business Chat
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No doubt if you have read this far, you want to know exactly where 
you can get this and how to download it in the next 30 seconds or less.  
Well, the announcement has been made.  Currently, Microsoft is testing 
Microsoft 365 Copilot with 20 customers, including eight in Fortune 500 
enterprises.  They will be expanding these Previews to customers more 
broadly in the coming months and industry commentators believe it is 
likely to roll out in the US first (similar to other new initiatives).  

There have already been some interesting debates on the internet 
though, stemming from Github Copilot.  Some are concerned whether the 

software is “raiding” copyrighted material out there already.  However, 
various third parties have commented that copyright law has only ever 
applied to intellectual creations – so where there is no creator, there is 
no work.  This means that machine-generated code like that of GitHub 
Copilot is not a work under copyright law at all, so it is not a derivative 
work either.  To be clear, this is not SumProduct’s advice, we are merely 
restating comments made by more learned folk than ourselves.

Whatever, the future’s coming: watch this space!

Want it..?

With many of us currently “working from home” / quarantined, there 
are only so Zoom / Teams calls and virtual parties you can make 
before you reach your (data) limit.  Perhaps they should measure data 
allowance in blood pressure millimetres of mercury (mmHg).  To try and 

keep our readers engaged, we will continue to reproduce some of our 
popular Final Friday Fix challenges from yesteryear in this and upcoming 
newsletters.  One suggested solution may be found later in this newsletter.   
Here’s this month’s…

It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  This month, we again look at 
interactive charts, this time using Drop-down Lists.

To recap, last newsletter we began considering interactive charts, where we may add a data selection option to charts, for example, through a Check 
box or a Drop-down List.  In last month’s article, we discussed how to create Check Boxes using Form Controls.  Now, let’s see how we may create a 
Drop-down List. 

To facilitate the conversation with customers upon placing an order, the operator wants to view the five most recent orders from a given customer.  
Specifically, when a customer is selected from the list in cell H2 (see image above), their last five order dates will appear in cells G6:G10 in descending 
order, together with the related order volumes.  

Can you get the list in cells G6:G10 in just two steps? 

Sounds easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  

This month’s challenge is to generate the list of the most recent items in a list simply using Excel formulae.

As an example, there is an Order_Database data set which contains details of Customer Name, Order Date and Order Volume over the time:

Beat the Boredom Challenge

Charts and Dashboards
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First, in the chart data area, we will add a column, e.g. ‘Sales by group’, with which we will later build our chart.  We will also add a list of Groups, 
with a blank cell at the top (highlighted in green in the image below).  Later, we will add a cell link to this.

We navigate to the Developer tab on the Ribbon.  We choose Insert -> Form Controls and click the Combo Box (the second left icon on the top row):

We need to make sure we choose the Combo Box from the ‘Form Controls’ group, not the ‘ActiveX Controls’ group – which is for VBA.  If you 
inadvertently choose the wrong version, you will notice that there is no Control tab in the ‘Format Control’ dialog:

Having selected the Form variant, by holding the ALT key and click on a cell in the worksheet, a box with an arrow icon will appear that may be 
snapped to grid:
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Next, right-click on the icon on the work sheet and click ‘Format Control…’.  In the Control tab, to define the ‘Input range’, we will select the list of 
groups in cell K12:K16, and refer the ‘Cell link’ to the blank green cell, which is cell K11.  

Then, we will resize the arrow box (if necessary).  As we choose one item from the list, note that the cell link will reflect its index number (i.e. position 
in the list):

Now, we need to match the sales figures corresponding to the group 
that we have chosen from the drop-down menu.  This can be done easily 
using the INDEX function.  The ‘Sales by group’ cell will be the index result 
from the corresponding range chosen; the array in this example has only 

one row, so only one reference is required, whether the range were to 
consist of one row or one column.  Here, if we choose Biz Supplies from 
the list, the cell link shows number one [1] – as this is the order of Biz 
Supplies item in the list, this will also be the column number to index.
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Then we can build a chart on the ‘Sales by group’ column based on Quarters.  We may also need to bring the drop-down box to front to insert to the 
chart.  To insert the Drop-down List, just drag the icon to the chart:

This chart is now interacted accordingly to our group selection using the Drop-down List.

More next month…

We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.   
This month we discuss how to get the intended format.

It’s easy enough to get on a cell’s case as we explored last month, but 
what if we wanted to find a cell that is formatted in a particular way?  
Like cells that have been bolded or have a specific background colour?

This is where the SearchFormat parameter comes in.  This is a Boolean 
parameter that tells the Find method to search a particular format.  But 
how do we set the format?

This is where we have to declare the FindFormat object.  FindFormat is a 
special object property of the Application where you may set particular 

formatting details to search in the Range.Find method.  All we need to 
do is set the FindFormat properties as if we were setting the properties 
of any given Range.

For example, if we wanted to set the text to be bold, we might use

Application.FindFormat.Font.Bold = True

Let’s review the search range we’ve been using the last few months:

Visual Basics
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In our range that we’ve been using, some of the cells have been highlighted yellow.  The RGB (red, green, blue) code for that colour is R = 255, G = 
255 and B= 0 (note this information can be found by going into the “Custom” colours and it will show the RGB code for the chosen cell).  To search 
for that particular format, we could use

Application.FindFormat.Interior.Color = RGB(255, 255, 0)

So how would this apply in our Macro?

Sub FindFormat()

    Dim searchRange As Range

    Set searchRange = Range("A1:E10")   

    Application.FindFormat.Interior.Color = RGB(255, 255, 0)

    Dim foundrange As Range

    Set foundrange = searchRange.Find("upon", Lookat:=xlPart,  
    MatchCase:=False, searchformat:=True)

    If foundrange Is Nothing Then

        Debug.Print "not found!"

    Else

        Debug.Print foundrange

        Debug.Print foundrange.Address

    End If

End Sub

Easy!

Now we may add multiple formatting details to a cell.  We could do this:

Sub FindFormat()

    Dim searchRange As Range

    Set searchRange = Range("A1:E10")

    Application.FindFormat.Interior.Color = RGB(255, 255, 0)

    Application.FindFormat.Font.Color = RGB(255, 0, 0)

    Dim foundrange As Range

    Set foundrange = searchRange.Find("upon", Lookat:=xlPart,  
    MatchCase:=False, searchformat:=True)

    If foundrange Is Nothing Then

        Debug.Print "not found!"

    Else

        Debug.Print foundrange

        Debug.Print foundrange.Address

    End If 

End Sub
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There is a cell formatted in that particular way despite there is no cell with the word “upon” in the search range.  We can easily find just the format 
by giving it an empty string, i.e. “” to search for instead:

Sub FindFormat()

    Dim searchRange As Range

    Set searchRange = Range("A1:E10")

    Application.FindFormat.Interior.Color = RGB(255, 255, 0)

    Application.FindFormat.Font.Color = RGB(255, 0, 0)

    Dim foundrange As Range

    Set foundrange = searchRange.Find("", Lookat:=xlPart,  
    MatchCase:=False, searchformat:=True)

    If foundrange Is Nothing Then

        Debug.Print "not found!"

    Else

        Debug.Print foundrange

        Debug.Print foundrange.Address

    End If 

End Sub

There are a lot of different ways we could format a cell, but the one thing the FindFormat object will not allow us to set is a particular Style.  Since 
we may assign multiple properties in the Application.FindFormat, it is easy to reset in order to search a different format later on with the simple 
line:

Application.FindFormat.Clear

That’s it for the Find method.  More next month.

We continue our series on the Excel COM add-in, Power Pivot.  This month, we consider a calculation that is a little more awkward than you might 
think at first...

CAGR stands for Compound Annual Growth Rate.  It describes the rate at which an investment would have grown over several years if it had grown 
at the same rate every year on a compounding, rather than simple, basis. 

Power Pivot Principles
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The CAGR metric is calculated using the following formula:

If we were to fit this entire formula into a single measure it may get messy and confusing for other users, so let’s step it out. 

We will need to create several measures to calculate the individual pieces the CAGR formula.  Of course, this is not the only way to calculate CAGR in 
Power Pivot, but this is the way we’ve decided to go about it.  Therefore, let’s break it down: we will need the following measures to calculate CAGR:

	 1.	 a measure to retrieve the First Year in the data set 
	 2.	 a measure to retrieve the Last Year in the data set
	 3.	 a measure to calculate the Number of Years between the First Year and Last Year in the data set
	 4.	 a measure to aggregate the Sales in the data set
	 5.	 a measure to calculate the Sales in the First Year of the data set
	 6.	 a measure to calculate the Sales in the Last Year of the data set
	 7.	 finally, a measure to calculate CAGR. 

The First Year measure is calculated as follows: 

=MIN('Calendar'[Year])

The Last Year measure is very similar:

=MAX('Calendar'[Year])
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The Number of Years measure is simply calculated as the difference between the two years.  Unlike calculating dates, you need to resist the urge of 
adding one to this calculation as there is only one year’s growth between the first year and the next year, etc.

	 •	 =[Last Year]-[First Year]

The sales aggregation measure is given by Sales:

=SUM('Sales Table'[Total Sales])

To calculate the Sales in First Year measure: 

=CALCULATE(
[Sales],

		  FILTER(
			   'Calendar','Calendar'[Year]=[First Year]
		  )
	 )
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There is therefore no surprise (hopefully!) that Sales in Last Year measure is calculated as follows: 

=CALCULATE(
	 [Sales],
		  FILTER(
			   'Calendar','Calendar'[Year]=[Last Year]
		  )
	 )

The CAGR measure is thus given by: 

=([Sales in Last Year]/[Sales in First Year])^(1/[Number of Years])-1
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This all seems to make sense.  That should be it: let’s create the PivotTable.  However, trying to plot our CAGR measure on a PivotTable we get the 
following message:

Something is not right!  Let’s plot the individual measures onto a PivotTable to see if we can figure it out:

It appears that our First Year and Last Year measures aren’t working as we intended, hence causing our Number of Years measure to return with zero 
[0] for every year.  This causes a division by zero error in our CAGR measure. 

How do we fix this?  

The first and last year measures return with the row’s first and last years.  This is because these measures are subject to the PivotTable row filters.  
We are going to have to tweak the measures for them to consider the entire range of data, despite these row filters.

In this case we will have to use the ALL function.  

We have to modify the first and last year measures.  The First Year measure should be revised as follows:

=CALCULATE(
	 MIN(
		  'Calendar'[Year]),
		  ALL(
			   'Calendar'
		  )
	 )
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Similarly, the Last Year measure should be adapted too:

=CALCULATE(
	 MAX(
		  'Calendar'[Year]),
		  ALL(
			   'Calendar'
		  )
	 )

Our CAGR measure now calculates on the PivotTable:

Great, we finally have a working CAGR measure!  Unfortunately, the 
measure only calculates the CAGR for the last year, what if we want the 
progressive CAGR for each year?  

The reason why our CAGR formula is not calculating dynamically is 

because we are using the Last Year measure, which is currently set to 
retrieve the last year in our data set.  To avoid confusion, we are going 
to create a measure that retrieves the current year called Current Year:

=MAX('Calendar'[Year])
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Now we modify our CAGR measure to use the Current Year measure: 

=([Sales in Current Year]/[Sales in First Year])^(1/[Number of Years])-1

However, attempting to put our CAGR measure in the PivotTable will result in this error: 

This is because the number of years for the 2018 period is zero [0], and we can’t divide by zero.  In this scenario, we should use the DIVIDE function 
to create our CAGR Dynamic new-and-improved measure.  You may recall the DIVIDE function from last month’s newsletter!

=DIVIDE(
	 [Sales in Current Year],[Sales in First Year]
		  )
			   ^DIVIDE(
				    1,[Number of Years]
				    )-1
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The DIVIDE function manages our division by zero problem by returning with BLANK() when the denominator is zero.  Therefore, this gives us the 
dynamic CAGR calculation we require:

More Power Pivot Principles next month.

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we review 
some useful ways to manipulate dates in M.

This month, we are going to consider various Date() M functions that can be used to create dates from an existing date, for example, by adding days 
or weeks to the original date.  To this end, if you read this nicely, we may even provide an example for each function.

Power Query Pointers

Date.AddDays(datetime as datetime, days as number)

This function returns a Date / DateTime / DateTimeZone value with the 
day portion incremented by the number of days provided.  It also handles 
incrementing the month and year portions of the value as appropriate.

As you may see below, we have some expense data from our reliably 

non-existent salespeople.  It is in their contracts that they will be 
reimbursed within 30 days of an expense being incurred, so we need to 
calculate when this date will be.

In ‘Custom Column’ on the ‘Add Column’ tab, let’s create a new column.

Date.AddDays

mailto:contact@sumproduct.com
http://www.sumproduct.com
http://www.sumproduct.com/blog
https://msdn.microsoft.com/en-us/query-bi/m/date-adddays


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

The M formula used is

= Date.AddDays([Date], 30)

We can now see the deadline of when each expense should be paid.

Date.AddMonths(datetime as datetime, n as number) as nullable datetime

This returns a DateTime value with the month portion incremented by n months.

If the salespeople’s contracts showed that they must be paid for their expenses within a month of incurring them, we could use this M function to 
calculate the due date, viz.

Date.AddMonths
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The M formula used here is

= Date.AddMonths([Date], 1)

The new due date has been calculated correctly.

Date.AddQuarters(datetime as datetime, quarters as number) as datetime

This function returns a Date / DateTime / DateTimeZone value 
incremented by the number of quarters provided.   Each quarter is 
defined as a duration of three months.  It also handles incrementing the 
year portion of the value as appropriate.

We have decided that the payment will be marked as “aged” once we 
reach the same position in the next quarter.  To determine the date this 
will happen, let’s add a quarter to our due date:

Date.AddQuarters
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The M formula here is

= Date.AddQuarters([1 month due date], 1)

The aged debt date has been calculated correctly.

Date.AddQuarters(datetime as datetime, quarters as number) as datetime

This returns a Date / DateTime / DateTimeZone value incremented by 
the number of weeks provided.  Each week is defined as a duration of 
seven days.  It also handles incrementing the month and year portions 
of the value as appropriate.

We may also increment the date by a number of weeks, so we’ll use 
this functionality to create a date to review the expense payment.

Date.AddWeeks
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The M formula used here is

= Date.AddWeeks([#"Aged Debt Date (from 1 month due date)"], 2)

Therefore, we will review if the payment has been made two [2] weeks after it becomes an aged debt.

We can now see the review date.

Date.AddYears(datetime as datetime, years as number) as datetime

This function returns a DateTime value with the year portion incremented by years.  This of course is when I will actually pay the expenses!

Date.AddYears
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The M code used here is

= Date.AddYears([Review By], 1)

We can now see when the poor salespeople will finally be paid their expenses.

More next time.

First and foremost, after almost 10 years, support for Windows 8.1 ended 
on January 10 (why a Tuesday, no one seems to know!).  Accordingly, 
Microsoft will cease supporting Power BI Desktop on Windows 8.1 from 
the end of January 2024.  Thereafter, Power BI Desktop will only be 
supported on Windows 10 and later editions.  Furthermore, the January 
2024 release of Power BI Desktop for Report Server will be the last release 
to support Windows 8.1, and this version will only receive security updates 
until January 2025 per Microsoft’s Modern Lifecycle Policy.

Moving on to the continuation of Power, in this release you’ll find On-
object interaction, which allows you to right-click on a visual to access the 
Format pane and updates to the way you can apply slicers on your reports 
using a new ‘Apply all slicers’ button.  There’s also Multiple Audiences 
in the Power BI app, email subscriptions for scorecards and the General 
Availability of Storytelling in PowerPoint. 

Power BI Updates
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The full list is as follows:

Reporting

	 •	 ‘Apply all slicers’ button, ‘Clear all slicers’ button and 
		  ‘Optimization presets’ update

	 •	 New styling for the Format Pane

	 •	 On-object interaction (opt-in) in Preview

	 •	 Visual container improvements

Data connectivity

	 •	 Google BigQuery and Google BigQuery Azure AD (connector  
		  update)

	 •	 Azure Databricks and Databricks (connector update)

	 •	 Dremio Cloud (connector update)

	 •	 FactSet RMS (connector update)

	 •	 SurveyMonkey (connector update)

Service

	 •	 Storytelling in PowerPoint now Generally Available

	 •	 Power BI org app Multiple Audiences now Generally Available

	 •	 Announcing new Scanner API scenarios

	 •	 Email Subscriptions

Mobile

	 •	 Discover external orgs content in your Mobile application

	 •	 Grant access on the go

Visualisations

	 •	 New visuals in AppSource

	 •	 Financial Reporting Matrix v7.0

	 •	 Acterys Variance

	 •	 Feature Summary for Drill Down Combo PRO

	 •	 Gantt Chart by MAQ Software (Premium).

Let’s look at each in turn.

When Microsoft released the Public Preview of the ‘Optimize’ Ribbon 
with Pause visuals for authoring reports, many users enquired whether 
there was a way to allow end users to make slicer selections and have 
the report visuals only update when they have finished making all slicer 
selections.  And the answer is now yes.

The ‘Apply all slicers’ button may be added in three ways:

	 1.	 From the ‘Optimize’ Ribbon -> ‘Apply all slicers’ button

	 2.	 From the ‘Insert’ Ribbon -> Buttons -> ‘Apply all slicers’

	 3.	 By choosing the ‘Apply all slicers’ action on any existing button 	
		  in your report.

You can add as many of these buttons as you wish to your report page.  
When at least one of them is visible on the page, all the slicers on your 
report page will take selection changes but will only apply them to the 
other report visuals when the button is clicked.  If you hide or delete the 
last ‘Apply all slicers’ button on a report page, then the slicers simply 
behave like they did before, generally instantly applying the selections 
as you make selections.

This ‘Apply all slicers’ button is similar to the existing single ‘Apply’ 
button on slicers in that they both do not apply the slicer selections to 
other visuals until you click the button.  Unlike the single ‘Apply’ button 
on slicers, the ‘Apply all slicers’ button will allow you to make selections 
across multiple slicers and then apply them in one click.  For the best 
query reduction experience with slicers, it’s recommended you use the 

‘Apply all slicers’ instead of the single ‘Apply’ button for slicers.  The 
single ‘Apply’ button for slicers is still available and will continue to work 
on existing reports.  The Optimization preset for query reduction has 
been adjusted to no longer add the single ‘Apply’ button for slicers on 
slicers and recommends the ‘Apply all slicers’ button instead.

‘Apply all slicers’ button, ‘Clear all slicers’ button and ‘Optimization presets’ update
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The ‘Clear all slicers’ button has also been added: when there are several 
slicers on a report page and you want a way to quickly clear all their 
selections, add the ‘Clear all slicers’ button and users may do so in one click.

Finally, the ‘Optimize’ Ribbon with Pause visuals, Optimization presets 
and the quick access to ‘Apply all slicers’ button is on by default as a 
Preview feature starting with this release.

Microsoft has noted and addressed customer feedback on the depth perceived by the white background and drop shadow treatment, which has 
apparently caused dizziness from the new Format pane.  Therefore, this update darkens the style and adds borders instead of drop shadows when 
the operating system (OS) setting for reduced motion is enabled.

New styling for the Format Pane

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

On-object is a new way to build and format visuals.  Microsoft has 
commissioned various research studies which have advised that many 
feel Power BI Desktop is hard to use.  If I am to opine personally, I 
would probably say the constant moving of things does cause user 
consternation and exasperation.  Indeed, Microsoft has stated that its 
staff have witnessed countless new users struggle to navigate the user 
interface (UI) to perform simple actions such as completely missing the 

Fields pane, being unable to add data to the correct field wells, hunting 
around the Format pane to rename, change colours or format text styles 
for their visual.  These same users instinctively right-click on areas of 
the visual expecting a menu to help.  Aligning to Power BI’s new “Office-
like” strategy, this update introduces On-object, a new way to build and 
format visuals directly on the visual.

On-object interaction (opt-in) in Preview

Current Format pane New Format pane style With reduce motion setting
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Try it out for yourself.  Simply switch on the Preview: File -> Options and settings -> Options -> Preview Features -> On-object interaction.

With this release, Power BI has introduced four key features to help you customise your visuals’ containers.

You can now turn on a subtitle that can be used to add extra context to your visuals.  You’ll find the new ‘Subtitle’ toggle in the ‘Title’ settings card 
of the Formatting pane.

Visual container improvements

SUBTITLE
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To visually separate the visual header from its contents you can add a divider line.  You can find the ‘Divider’ option in the ‘Title’ settings card of the 
Formatting pane, below the new ‘Subtitle’.

Here’s an example visual container with Subtitle and Divider both switched on:

DIVIDER

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

In addition to the Subtitle and Divider on your visual container, you can control the space below each component too.  You’ll find the ‘Spacing’ setting 
at the bottom of the ‘Title’ settings card of the Formatting pane.

You can now control the container’s margin to create a negative space making the visuals look more professional and appealing.  You’ll find this new 
option in the Properties card of the Formatting pane.

This update contains bug fixes on the Azure Active Directory Single-Sign On scenario.

SPACING

PADDING

Google BigQuery and Google BigQuery Azure AD (connector update)
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The Azure Databricks and Databricks connectors have been updated.  This latest release contains the following fixes and improvements:

	 •	 fixed DAX DAY, MONTH and YEAR queries.  Now, the DAX DAY query works and MONTH and YEAR DAX queries generate more efficient 	
		  queries pushed down to the Databricks SqlWarehouse

	 •	 improved Native Query by caching the result of schema inference query instead of issuing multiple schema inference queries

	 •	 improved Native Query performance by utilizing LIMIT 0 query for schema inference (clear as mud!).

The Dremio Cloud connector has been updated and has now removed the Beta flag.  Further, it is now Generally Available.

The FactSet RMS connector has been updated to include support for Contact data stored in IRN, as well as improvements to Notes and Custom 
Symbol retrieval.

 The SurveyMonkey connector has been updated to Version 1.2.  Modifications include:

	 •	 Major performance enhancements

	 •	 Minor bug fixes

	 •	 Support for the following SuveryMonkey features:

			   ○	 Custom Variable exporting

			   ○	 Sentiment analysis

			   ○	 Tags.

This update also sees the General Availability of Power BI’s integration with PowerPoint that enables users to include interactive Power BI visuals in 
their PowerPoint presentations.

With the now-General Availability of the Power BI add-in for PowerPoint:

	 •	 the Power BI / PowerPoint integration will be enabled in all Microsoft clouds

	 •	 users will be able to add single visuals to PowerPoint slides, not just complete report pages

	 •	 recipients may use smart insights to get a text narrative of the data displayed in the add-in.

Azure Databricks and Databricks (connector update)

Dremio Cloud (connector update)

FactSet RMS (connector update)

SurveyMonkey (connector update)

Storytelling in PowerPoint now Generally Available
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Since the announcement in August last year regarding launching the 
Public Preview of Multiple Audiences for Power BI org apps, this feature 
has now been made Generally Available.  With this, the multiple audience 
feature will now be supported by Power BI Mobile.  As stated, with 

multiple audiences for an app, Power BI App author can create multiple 
audience groups within the same application and assign different 
permissions to each group.

The Scanner API is part of the Power BI admin API.  It enables administrators 
to efficiently and automatically retrieve valuable information about their 
organisation’s Power BI assets, such as inventory, metadata and lineage.  
In turn, they can leverage this information for their own custom-made 
solutions.

The API was developed with the aim of improving the efficiency 
and performance of the Power BI scan so that it could support large 
numbers of data assets while still conforming to the security practices 

of organisations.  The scanner supports service principle authentication 
and incremental scanning, and returns metadata such as endorsement 
status, sensitivity label, etc.

The Scanner API attained General Availability over a year ago, and a 
growing number of entities now actively use it to better understand 
their products and to get information that helps them achieve their 
governance goals.

This also now supports:

	 •	 additional artifact metadata: scheduled refresh settings and RDL data source properties

	 •	 dataset sub-artifact metadata: dataset tables whose ‘Enable load’ property is set to OFF, RLS configuration
	 •	 dataset sub-artifact coverage: XMLA changes, Autogenerated datasets, Datasets created via ‘Quick create’ and ‘Quick share’, Web 	
		  modelling modifications

	 •	 datamarts support.

The image below is an example for scheduled refresh settings for Power BI models (dataset, dataflow, datamart):

Power BI org app Multiple Audiences now Generally Available

Announcing new Scanner API scenarios

This month also sees the release of email subscriptions for scorecards.  Subscriptions enable you to receive email notifications and stay up to date on 
the scorecards that matter most to you and your team.

To set up a subscription, select the Subscribe button in the Ribbon:

Email Subscriptions
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Then, select ‘Add a new subscription’ in the pane that opens on the right side:

Enter the details about the subscription such as the name for the 
subscription, subject and email message details.  Then, set the frequency 
on how often you want to receive the emails such as hourly, daily, weekly 
or monthly.  Also, you may set a scheduled time for the subscription, such 
as on the hour, or at 15, 30 or 45 minutes past, AM or PM, and specify 

the time zone.  You may then select a ‘Start date’ and optionally an ‘End 
date’ for the subscription.  You can also include a link to the scorecard in 
the email and give recipients permission to view the scorecard.  Finally, 
select ‘Save and close’.  After saving, you can edit the subscription, turn 
it on and off or delete the subscription.

Recipients will receive an email from Power BI with a table containing the scorecard data such as metric name, status, values and due date.  The table 
will show up to 50 metrics, viz.
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You can add up to 24 subscriptions per scorecard, with unique recipients, 
times and frequencies for each subscription.  You can see all the 
subscriptions by opening the Subscriptions pane from a scorecard in ‘My 
workspace’, and selecting ‘Manage all subscriptions’, or from under the 
Settings -> Subscriptions tab in the upper right corner of Power BI Service.

Note that you can subscribe to scorecards if you have a Pro license or 
PPU license or if scorecard is in a workspace backed by Premium capacity.  

You can subscribe other team members if in addition to the above, you 
are a Contributor, Member or Administrator in that workspace.  If the 
scorecard isn’t hosted in a Premium capacity, others must also have a Pro 
license.  You can add other email addresses in the same domain to the 
subscription.  If the scorecard is hosted in a Premium capacity, you can 
subscribe group aliases, whether they’re in your domain or not.  You may 
subscribe external users if scorecard is hosted in a Premium capacity too.

It has become easier to access your external content from your Power 
BI mobile app.  You no longer need to have a link to access such items.  
If you have access to items from external organisations, you can now 
have these items always show up for quick access on the app’s home 
page by default.  Just tap the newly added drop down arrow on the 
third content strip to change ‘Recommended’ to ‘From external orgs’.   

You can also access your external items by tapping ‘More options…’ and 
selecting ‘From external orgs’.

Tapping an item takes you to the external tenant, where as a guest user 
you’ll be able to view all the content that’s been shared with you there.

You now get a push notification on your mobile app whenever someone requests access to one of your reports.  Simply tap the notification to 
respond immediately.

Discover external orgs content in your Mobile application

Grant access on the go
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There are two for this month:

	 •	 Horizontal Bullet Chart with Label

	 •	 Banzae BI Dashboard.

Version 7.0 of the Financial Reporting Matrix is now out.  The ‘Export to Excel feature grants users the ability to export their matrix, preserving its 
aesthetic and professional quality.  With a few clicks, the matrix can be exported to Excel.

Drill Down Combo PRO allows report creators to build charts of categorical data.  You can choose from multiple chart types and create Column, Line, 
Area and their Combination charts.  There are also customisation options to make your chart unique whilst enhancing the readability of your data 
with features like conditional formatting and dynamic thresholds.

This provides KPI cards with planning and forecasting options.  You may switch between different display options: absolute, relative and waterfall 
in a vertical or horizontal small multiple display.  Further, you may also set cut off period and see projected results if your plan changes in real-time.

Features include:

•	 analyse actual / target variances with support for small multiples and four [4] visualisation types (combined, absolute / relative variance 	
	 and waterfall) and zoom in option

•	 advanced forecasting and planning on any level by dragging on the bars.  Set cut off periods see projections based upon plan changes in 	
	 real-time

•	 fully configurable KPI indicator display

•	 option to display total across all cards

•	 zoom into charts

•	 category drill down

•	 write back, planning and forecasting (requires Acterys subscription)

•	 supports all Power BI features, such as custom ToolTips and drill through.

New visuals in AppSource

Financial Reporting Matrix v7.0

Feature Summary for Drill Down Combo PRO

Acterys Variance
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Main features include:

	 •	 conditional formatting: compare results against forecasts by automatically adjusting formatting based upon a numerical value

	 •	 full customisation: customise X and Y axes, the legend, outline and fill settings

	 •	 choose normal, 100% proportional or zero-based stacking
	 •	 set up to four [4] static and / or dynamic thresholds to demonstrate targets

	 •	 customise multiple series simultaneously with series and value label defaults.

Popular use cases include:

	 •	 sales and marketing: sales strategies, results, marketing metrics

	 •	 human resources: hiring, overtime and efficiency ratios by department

	 •	 accounting and finance: financial performance by region, office or business line

	 •	 manufacturing: production and quality metrics.

ZoomCharts Drill Down Visuals are known for interactive drilldowns, cross-filtering and numerous customisation options.  They support interactions, 
selections, custom and native ToolTips, filtering, bookmarks and context menus.

A premium version of the visual with the following advanced features has now been released.  Features include:

	 •	 progress bar: accepts % and measure values between zero [0] and one [1]

	 •	 task status: accepts categorical values for mapping status flags for each task

	 •	 milestones: accepts up to five [5] date fields for showing milestone shapes as per user settings

	 •	 configurable bar height: user setting to change the height of task rows

	 •	 category limit increased to 10 (from four [4]).

Gantt Chart by MAQ Software (Premium)
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That’s it for this month: more anon.

This month’s updates include the ability to manually sort row and column values in PivotTables to users of Excel for the web.  For Insiders, users can 
also check out automatic recalculation optimisation – but that’s not all. 

The full list is as follows:

Excel for the web

	 •	 PivotTables: manual sort (drag) of rows and column values

Excel for Windows

	 •	 Automatic recalculation optimisation (Insiders)

	 •	 Block untrusted XLL add-Ins (Insiders)

Excel for Mac

	 •	 Power Query Editor:

			   ○	 Import data from additional sources

			   ○	 Import data from SQL Server databases (Insiders) 

	 •	 Automatic recalculation optimisation (Insiders).

Let’s plough through.

New Features for Excel

Excel for the web now allows manual sorting for PivotTables and PivotCharts.  Now you may customise the sort order of your PivotTable row and 
column items beyond the standard ascending and descending options.  This feature, previously only available in the Excel desktop application, allows 
you to manually sort specific row or column items by dragging them or using the context (right-click) menu. 

PivotTables: manual sort (drag) of rows and column values
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For Excel for Windows and Excel for Mac, Microsoft is minimising the 
risk of slow performance by limiting the recalculation process to the 
active workbook and any of its interdependent workbooks only.  This 
improvement reduces the chances of slowness or freezing in the active 
workbook (the one you are actively working in) when multiple workbooks 
are open. 

The introduction of the single document interface (SDI) in Excel 2013 
made it possible for users to open and run multiple, unrelated workbooks 
in a single instance of Excel.  Additionally, when using the Automatic 
Calculation mode, any of these workbooks had the potential to trigger a 

recalculation of all open workbooks, which increased the risk of slowing 
down the performance of the active workbook.

Therefore, Microsoft is minimising the risk of slowness and increasing 
performance by limiting the recalculation process to the active workbook 
and any of its interdependent workbooks.

It should be noted that workbooks with real-time streaming functionality 
(such as Realtime Data), as well as recalculation initiated either 
programmatically or manually by pressing the F9 key or selecting 
Formulas -> Calculate Now are exceptions to this optimisation.

Add-ins can add a lot of functionality to Microsoft 365, but they can also 
be employed by bad actors to disseminate malware.  Thus, Microsoft has 
taken steps to help protect users by blocking XLL add-ins.  Whether this 
is overkill, we will have to wait and see.

With this update in Excel for Windows (Insiders), you will no longer be 
able to enable XLL add-ins in files obtained from the internet with the 
click of a button, which will either be a blessing or a curse.  Instead, a 

message will now appear, notifying you of the risk you are taking and 
offering a link to more information about possible workarounds.

It should be noted that this setting change only blocks XLL add-ins – not 
all add-ins.  For example, add-ins from the Store will not be affected.

If you open an Excel file that contains an XLL add-in from an untrusted 
source, the following dialog will appear:

In the Microsoft Excel Security Notice message box, review the source of the add-in and click the ‘Leave this add-in disabled’ button, for example.

This feature is rolling out to Insiders on Excel for Windows who are running Version 2302 (Build 16130.20128) or later.

This feature is available to Insiders running:

	 •	 Windows: Version 2208 (Build 15529.10000) or later
	 •	 Mac: Version 16.64 (Build 22081401) or later.

Automatic recalculation optimisation (Insiders)

Block untrusted XLL add-Ins (Insiders)
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The ability to refresh data was introduced into Excel for Mac back in 2020, with the ability to import (some) data in 2021.  But now, you can clean / 
shape the data with numerous transformations now available in Apple Land.

To access the new features, on the Data tab, click the ‘Get Data (Power Query)’ button:

Then, click on ‘Launch Power Query Editor’ to open the Query Editor.

You can now author queries from local files, SharePoint, OData and various other sources with the Power Query Editor in Excel for Mac.

Power Query Editor
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You can shape and transform your data using the Query Editor as you would in Excel for Windows. When you’re done, simply click the ‘Close & Load’ 
button on the Home tab.

And that’s it!

Supported data sources include Blank Query, Blank Table, CSV, JSON files, local tables and ranges, Microsoft SQL Server, OData, SharePoint, SharePoint 
Folders, SharePoint Lists, text, XLSX and XML.

You should note that you may also access the Query Editor from the data import flow by clicking the ‘Get Data (Power Query)’ button, choosing a 
data source, and clicking the ‘Transform Data’ button:
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This feature is Generally Available in Excel for Microsoft 365 for Mac version 16.69 (23010700) or later.

The updated version of the grid with all the new features is fast becoming too complicated to show clearly here.  Nonetheless, you can find the 
interactive links at aka.ms/ExcelFeaturesFlyer.
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More next month, we’re sure.

There’s a great trivia question out there that asks, which is the only letter 
of the alphabet for which there is no Excel function?  Wiser hands than 
mine say this is “J”.  We say, “it depends”.  If they have Excel 2013 or later, 
“they” would be right as the JIS function was “retired” in this edition.

The JIS function (such an unfortunate name…) was renamed in Excel 
2013 as DCBS (pretty obvious if you think about it – not).  This function 
returns the text string converted from single byte (SCBS) to double byte 
(DCBS) characters.

A double-byte character set (DBCS) is a character encoding in which either 
all characters (including control characters) are encoded in two bytes,  

or merely every graphic character not representable by an accompanying 
single-byte character set (SBCS) is encoded in two bytes (Han characters 
would generally comprise most of these two-byte characters).  A DBCS 
supports national languages that contain many unique characters or 
symbols (the maximum number of characters that can be represented 
with one byte is 256 characters, while two bytes can represent up to 
65,536 characters, i.e. 2562).  

Examples of such languages include Japanese and Chinese.  Korean 
Hangul does not contain as many characters, but KS X 1001 supports 
both Hangul and Hanja, and uses two bytes per character.

The A to Z of Excel Functions: JIS
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This function converts half-width (single-byte) letters within a character string to full-width (double-byte) characters.  The name of the function (and 
the characters that it converts) depends upon your language settings.

For Japanese, this function changes half-width (single-byte) English letters or katakana within a character string to full-width (double-byte) characters.

The JIS function employed the following syntax to operate:

JIS(text)

The JIS function had the following argument:

	 •	 text: this is required and represents the text you wish to convert from single byte to double byte characters.

It should be noted that:

	 •	 this function was removed in Excel 2013

	 •	 DCBS was introduced in Excel 2013 and has replaced this function
	 •	 this function does not appear in the Function Wizard

	 •	 if text does not contain any half-width characters, then text is not altered
	 •	 this function is used in connection to phonetics and using different types of fonts and languages

	 •	 you may use the ASC function to convert from double byte characters to single byte characters.

My example is extremely enlightening:

Imagine you toss an unbiased coin; half of the time it will come down heads, half tails:

The A to Z of Excel Functions: KURT
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It is not the most exciting chart we have ever constructed, but it’s a start.  

If you toss two coins, there will be four possibilities: two Heads, a Head and a Tail, a Tail and a Head, and two Tails.  

In summary, we should get two heads a quarter of the time, one head half of the time and no heads a quarter of the time.  Note that (1/4) + (1/2) + 
(1/4) = 1.  These fractions are the probabilities of the events occurring and the sum of all possible outcomes must always add up to 1.

The story is similar if we consider 16 coin tosses say:

Again, if you were to add up all of the individual probabilities, they would total to 1.  Notice that in symmetrical distributions (such as this one) it is 
common for the most likely event (here, eight heads) to be the event at the midpoint.

Of course, why should we stop at 16 coin tosses?

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

All of these charts represent probability distributions, i.e. it displays how 
the probabilities of certain events occurring are distributed.  If we can 
formulate a probability distribution, we can estimate the likelihood of 
a particular event occurring (e.g. probability of precisely 47 heads from 
100 coin tosses is 0.0666, probability of less than or equal to 25 heads 
occurring in 100 coin tosses is 2.82 x 10-7).

Now, assuming you can toss 100 coins, count the number of heads and 
record the outcome at one coin toss per second, it shouldn’t take you 
more than 4.0 X 1022 centuries to generate every permutation.  Even if we 
were to simulate this experiment using a computer programme capable 
of generating many calculations a second it would not be possible.  For 

example, in July 2022, a new computer (Frontier) was announced that 
could compute 1,000,000,000,000,000,000 calculations per second.  If 
we could use this computer, it would only take us a mere 4,020 years 
to perform this computation.  Sorry, but I can’t afford the electricity bill.  
Imagine the price per kwh by then!

Let’s put this all into perspective.  All I am talking about here is 
considering 100 coin tosses.  If only business were that simple.  Potential 
outcomes for a business would be much more complex.  Clearly, if we 
want to consider all possible outcomes, we can only do this using some 
sampling technique based on understanding the underlying probability 
distributions.

If I plotted charts for 1,000 or 10,000 coin tosses similar to the above, I 
would generate similarly shaped distributions.  This classic distribution 
which only allows for two outcomes is known as the Binomial distribution 
and is regularly used in probabilistic analysis.

The 100 coin toss chart shows that the average (or ‘expected’ or ‘mean’) 
number of heads here is 50.  This can be calculated using a weighted 

average in the usual way.  The ‘spread’ of heads is clearly quite narrow 
(tapering off very sharply at less than 40 heads or greater than 60).  This 
spread is measured by statisticians using a measure called standard 
deviation which is defined as the square root of the average value of 
the square of the difference between each possible outcome and the 
mean, i.e.

where:	 σ = standard deviation

	 N = total number of possible outcomes

	 Σ = summation

	 xi = each outcome event (from first x1 to last xN)

	 μ = mean or average

The Binomial distribution is not the most common distribution used in probability analysis: that honour belongs to the Gaussian or Normal 
distribution:

The Central Limit Theorem states that the sampling distribution of the 
sample means approaches a normal distribution as the sample size gets 
larger — no matter what the shape of the population distribution.  This is 
why this distribution is so important in probability and statistics.

Generated by a complex mathematical formula, this distribution is 
defined by specifying the mean and standard deviation (see above).   
The Normal distribution’s population is spread as follow:

Probability Distributions
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i.e. 68% of the population is within one standard deviation of the mean, 95% within two standard deviations and 99.7% within three standard 
deviations.

The formula for the Normal distribution is given by

and is regularly used for comparison purposes.

The KURT function returns the kurtosis of a data set.  Kurtosis characterises the relative peakedness or flatness of a distribution compared with the 
Normal distribution.  Positive kurtosis indicates a relatively peaked distribution.  Negative kurtosis indicates a relatively flat distribution.

The KURT function employs the following syntax to operate:

KURT(number1, [number2], ...)

The KURT function has the following arguments:

	 •	 number1, number2, …: the first argument (number1) is required, whilst the subsequent arguments are optional.  You may have  
		  between one (1) and 255 arguments to calculate kurtosis.  You can also use a single array or a reference to an array instead of arguments  
		  separated by commas.

It should be further noted that: 

	 •	 arguments may be numbers, or names, arrays or references that contain numbers

	 •	 logical values and text representations of numbers that you type directly into the list of arguments are counted

	 •	 if an array or reference argument contains text, logical values or empty cells, those values are ignored; however, cells with the value zero  
		  [0] are included

	 •	 arguments that are error values or text that cannot be translated into numbers cause errors

	 •	 if there are fewer than four data points, or if the standard deviation of the sample equals zero, KURT returns the #DIV/0! error value
	 •	 kurtosis is defined as: 

	 	 where s is the sample standard deviation.
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Please see my example below:

Well, we only seem to write about this function every other month..!

LAMBDA allows you to define a custom function in Excel’s very own formula language.   Moreover, one prescribed function may call another.  If the 
function calls itself, that’s an example of recursion, which is a way of a function calling itself, called recursion, which is a way… [get on with it – Ed.]

As a reminder, there are three key pieces of =LAMBDA to understand:

	 1.	 LAMBDA function components

	 2.	 Naming a lambda

	 3. 	 Calling a lambda function.

The A to Z of Excel Functions: LAMBDA
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Let’s take a simple example.  Consider the following formula:

=LAMBDA(x, x+1)

where we have x as the argument, which you may pass in when calling the LAMBDA, and x+1 is the logic / operation to be performed.  For example, 
if you were to call this lambda function and define x as equal to five (5), then Excel would calculate

5 + 1 = 6

Except it wouldn’t.  If you tried this you would get #CALC!  Oops.  That’s because it’s not quite as simple as that.  You need to name your LAMBDA.

To give your LAMBDA a name so it can be re-used, you have to use the Name Manager (CTRL + F3 / go to the Ribbon and then go to Formulas -> 
Name Manager):

Once you open the Name Manager you will see the following dialog:

You then click on ‘New’ and fill out the related fields, viz.

It’s no harder than clicking ‘OK’ at this point.

1. LAMBDA function components

2. Naming a lambda
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Now that you have done this, your first new lambda function may be called in just the same way as every other Excel function is cited, e.g.

=MYLAMBDA(5)

which would equal six (6) and not #CALC! as before.

You DON’T have to do it this way though if you don’t want to.  You may call a lambda without naming it.  If we hadn’t named this marvellous 
calculation, and simply authored it in the grid as we had first attempted, we could call it by simply typing:

=LAMBDA(x, x+1)(5)

This trick won’t always work though – and our topic for today is on precisely this issue caused by recursion…

3. Calling LAMBDA

To be clear, LAMBDA has no aversion; in fact, it enables it.  But it makes for a great sub-heading.  The “aversion” is that when you use recursion in 
a LAMBDA, 

LAMBDA(appropriate syntax)(variable or reference)

may not give the expected result.  Instead, it will most likely generate an error, making you think you have written your expression incorrectly.   
Let me illustrate with a simple example.  Consider the following:

In cell G12, I have typed the number nine (9), which generates the list of numbers one (1) through nine (9) from cell G18 downwards, using the 
SEQUENCE function, viz.

=SEQUENCE(G12)

For those who recognise this is a dynamic array function and that you require Office 365 at this juncture, you are quite right – but I need Office 365 
Beta version for the LAMBDA functions, so it’s OK.  I apologise if you don’t have Office 365, but again, you might wish to reconsider which version of 
Excel and Office you are running, in that instance.

LAMBDA’s Aversion to Recursion
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Cell G16 simply sums this list:

=SUM(G18#)

Therefore, inputting the numbers one (1) through (9) in cell G12 would generate the results

1, 3, 6, 10, 15, 21, 28, 36, 45, …

In cell G16.  These numbers are known as the triangle numbers 

in mathematics, for very obvious reasons.

I want to show you how you can generate this sequence using a LAMBDA.  Now, yes, I know the formula above works and you can even use the 
algebraic solution

=G12*(G12+1)/2

too, but the point is here, I want to show you how to create a recursive LAMBDA function that is simple to follow.  

On the Ribbon, go to the Formulas tab and click on ‘Name Manager’ (as above) (CTRL + F3) and click on the ‘New…’ button.

I have named my lambda function Triangle, and the reference (‘Refers to:’) is given by

=LAMBDA(x, IF(x<2, 1, x + Triangle(x-1)))

Here, the lambda function takes a parameter x and defines it as one (1) if it is less than two (2), else it takes the value x and adds the lambda value 
for x-1 – hence the recursion.  This lambda function has been named Triangle (in the ‘Name:’ box) and is referred to in the formula too.

Therefore, for x equals nine (9):

	 Triangle(9) 	 = 9 + Triangle(8)

			   = 9 + 8 + Triangle (7)

			   = 9 + 8 + 7 + Triangle (6)

			   = 9 + 8 + 7 + 6 + Triangle(5)

	 = 9 + 8 + 7 + 6 + 5 + Triangle(4)

	 = 9 + 8 + 7 + 6 + 5 + 4 + Triangle(3)

	 = 9 + 8 + 7 + 6 + 5 + 4 + 3 + Triangle(2)

	 = 9 + 8 + 7 + 6 + 5 + 4 + 3 + 2 + Triangle(1)

			   = 9 + 8 + 7 + 6 + 5 + 4 + 3 + 2 + 1

			   = 45
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Drawn out long hand, the recursion is clear. 

This presupposes that x is an integer, and I have ensured this by incorporating data validation (Data -> Data Validation or ALT + D + L) into my input 
cell (keep it simple!):

Now that the lambda function Triangle has been defined, the formula in Excel is easy:

I have purposely created a simple recursive formula to demonstrate how such a calculation might work.  In reality, recursive formulae are likely to be 
much more sophisticated and / or complex.  

Let’s assume that wasn’t the case though, and you wanted to check whether your formula was working.  Not everyone (anyone?) can type a formula 
and have it work first time, every time.  Many of us would want to try the formula in a cell first:

Oh dear.  That didn’t work.  Of course it doesn’t.  As explained above, it needs the parameter (x) to be defined:

Rats.  This is the problem I alluded to earlier.  My definition of the function refers to itself (i.e. recursion is exhibited).  The name has not yet been defined.

Now watch out here.  Note the function here is Triangle1, not Triangle.  There is a very important distinction.  If I use Triangle, a similar formula will work:

This is very easy to explain.  I have already defined Triangle in the Name Manager!  This is why I am using Triangle1 to avoid this classic gotcha.  

OK, let’s define Triangle1 then.  That will mean wrapping the expression in a LET function.  This allows you to stop writing the same expressions 
time and time again in a formula, or, as Microsoft puts it, it’s “…names on a formula level”.

This has not worked either, even though Triangle1 has supposedly been 
cited by LET.  The problem is, Triangle1 has not been defined when we 
are creating the lambda.  This where our trick comes in – which also 

explains the title for this article: it’s all about ME.  Let’s add a parameter 
(ME) to Triangle1, and replace the recursive call to Triangle1 with ME 
(ensuring you pass in ME as the first parameter):
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Believe it or not, we are getting somewhere now.  Even though #NAME? has been replaced with #VALUE!, the formula has evolved.  Assuming you have 
background error checking enabled (File -> Options -> Formulas -> Enable background error checking), you can click on the error to see the issue:

We have an incorrect number of parameters.  We have added a parameter to Triangle1 (namely, ME), so the final argument of LET (Triangle1($G$12)) 
should also have two parameters.  We do this by getting Triangle1 to refer to itself, viz.

	 •	 (x + 1)0 = 1 – which is the coefficient on the zeroth (0th) row

	 •	 (x + 1)1 = x + 1 = 1x + 1 – the coefficients 1 and 1 are on row 1 of Pascal’s Triangle
	 •	 (x + 1)2 = x2 + 2x + 1 = 1x2 +2x + 1 – the coefficients 1, 2 and 1 are on row 2 of Pascal’s Triangle
	 •	 (x + 1)3 = x3 + 3x2 + 3x + 1 = 1x3 + 3x2 + 3x + 1 – the coefficients 1, 3, 3 and 1 are on row 3 of Pascal’s Triangle, etc.

It works!  We have checked / debugged our LAMBDA in Excel.  We started 
by calling Triangle1(Triangle1,$G$12), and when we evaluate that lambda, 
we end up calling Triangle1(Triangle1,$G$12-1), etc.  

This technique has employed the ME parameter: by passing Triangle1 as a 
parameter to itself, it can then use that parameter to call itself.

Once you've got your head around this, proved for yourself Einstein’s 
Theory of General Relativity and demonstrated Schwarzschild’s solution 
to Einstein’s field equations using tensor analysis, you have probably got 
your lambda working properly!  Now, simply remove all references to ME.  
Exclude ME as the first parameter and replace the ME( calls with the defined 
name you want to use (here, Triangle1).  Therefore, in this instance,

Starting with a 1 in what is conventionally known as the “zeroth” row (!), 
each subsequent row’s value is calculated as the sum of the cell directly 
above it and the cell to the left of the cell above the cell you are in.  
Notice the triangle numbers occur in both the third column and the third 
diagonal from the top.

This is an almost “ultimate” recursion, as you can trace any number on 
any row back through its constituent elements higher up the Triangle.  
Note that this beast is useful in mathematics as this array displays the 
binomial coefficients of (x + 1)n.  For example:

Now, yes, I know, Excel has a function that calculates these coefficients – 
and hence any element of Pascal’s Triangle.  If you are often COMBIN the 
Excel functions to see how many subsets you can make, then COMBIN 
is for you.  This function returns the number of combinations for a given 

number of items (i.e. the number of distinct subsets of items where 
order is unimportant).  You should use COMBIN to determine the total 
possible number of groups for a given number of items.

=LET(Triangle1, LAMBDA(ME, x, IF(x<2, 1, x + ME(ME, x – 1))), Triangle1(Triangle1, $G$12))

becomes 

=LAMBDA(x, IF(x<2, 1, x + Triangle1(x – 1)))

i.e. we have proved our expression is correct.  We can now add this to the Name Manager.

Sorry to bring back childhood recollections of mathematics, but triangle (or triangular) numbers feature in Pascal’s Triangle:

Taking it Further: Pascal’s Triangle
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The COMBIN function employs the following syntax to operate:

COMBIN(number, number_chosen)

The COMBIN function has the following arguments:

	 •	 number: this is required and represents the number of items

	 •	 number_chosen: this is also required.  This denotes the number of items in each combination.

However, in the context of Pascal’s Triangle, it may be seen to be 

COMBIN(row_number, column_number)

where both row_number and column_number start at zero, rather than one for the reasons demonstrated above.

The technique for calculating this using a recursive lambda function is very similar to the Triangle example (above).  You can define Pascal in the 
Name Manager (CTRL + F3) as

=LAMBDA(row_num, col_num, IF(OR(row_num < 0, col_num < 0), 0, IF(row_num = 0, IF(col_num = 0, 1, 0), Pascal(row_num - 1, col_num - 1) + 
Pascal(row_num - 1, col_num))))

This may be checked in a cell using the ME technique (as above):

=LET(Pascal1, LAMBDA(ME, row_num, col_num, IF(OR(row_num < 0, col_num < 0), 0, IF(row_num = 0, IF(col_num = 0, 1, 0), ME(ME, row_num - 
1, col_num - 1) + ME(ME, row_num -1, col_num)))), Pascal1(Pascal1, $I$12, $I$13))

A better lambda might be Pascal_Row, where the time taken is proportional to n2:

=LAMBDA(a, b, LET(Pascal_Row,

   LAMBDA(ME, x,

      IF(x=0, 1, IF(x=1, {1, 1},

          LET(seq, SEQUENCE(, x + 1), previous_row, ME(ME, x - 1), shifted, IF(seq=1, 0, INDEX(previous_row, 1, seq - 1)),

               IFERROR(previous_row + shifted, 1)

)))), INDEX(Pascal_Row(Pascal_Row, a), 1, b + 1)))

This is achieved by calculating on a row, rather than an element, basis.

But even this may be improved upon.  Consider Pascal_Fast:

=LAMBDA(n, k,

    IF(k * 2 > n, Pascal_Fast(n, n - k),

    IF(k = 0, 1,

    LET(gcd_cutoff, 2 ^ 53 / n,

           previous, Pascal_Fast(n, k - 1) * (n + 1 - k) / k,

           IF(n <= gcd_cutoff, previous,

               LET(gcd, GCD(previous, k),

                      remainder, k / gcd,

                      previous / gcd * ((n + 1 - k) / remainder)))

))))

This Pascal lambda function is a more complex example of recursion 
that highlights an important design consideration.  On my reasonably 
powerful computer, when I tried to select an element from row 30 of 
Pascal’s Triangle, Excel took c.55 seconds to calculate, due to all the 
interim recursive calculations.  

Be careful.  Lambda calculations in Excel are very fast, but if you adopt 
an excessive recursive approach as I have done here, any powerful PC 
will be slowed down to a “crawling speed”.  The problem here is that the 
calculation speed in this instance is proportional to , where n is 
the row number.
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This is very quick compared to both of the previous alternatives, as the 
time here is proportional to just n, the row number.  The problem as you 
may have noticed here, is that as you maximise the iterative approach, 

the transparency of the calculation – for the average user – tends to 
become more and more opaque.  PhDs in Computer Science are available 
upon request.

As a compromise, perhaps 

=LAMBDA(n, k, IF(k=0, 1,  Pascal_Almost_As_Fast(n, k - 1) * (n + 1 - k) / k))

{Pascal_Almost_As_Fast) might work best, which takes approximately twice as long as the above monster (i.e. “almost” instantly).

Care with IFS and SWITCH

Given how calculations may “blow out” quickly when creating iterative functions, it’s best to avoid another classic gotcha.  Let me illustrate with 
one of the best-known iterative sequences, the Fibonacci sequence:

1, 1, 2, 3, 5, 8, 13, 21, 34, 55, 89, 144, 233, 377, …

This sequence is calculated as Fn = Fn-1 + Fn-2.

You might choose to define a lambda function using IFS as follows:

=LAMBDA(x, IFS(x=1, 1, x = 2, 1, TRUE, Fibonacci(x - 1) + Fibonacci(x - 2)))

If you are starting to follow lambdas, you should see this appears to make sense (the final argument of IFS, given the criterion is simply TRUE, resorts 
in advising what to do when x is neither equal to one (1) nor two (2)).  There is a problem though.  This function will run forever, since each parameter 
in this IFS statement must be evaluated before IFS gets evaluated.  Therefore, when evaluating Fibonacci(1), it will try to evaluate Fibonacci(0) + 
Fibonacci(-1), and so on.  Not good!  

Therefore, you should use IF instead:

=LAMBDA(x, IF(x = 1, 1,IF(x = 2, 1, Fibonacci(x - 1) + Fibonacci(x - 2))))

as IF does not evaluate a parameter it does not return.

Be advised, SWITCH exhibits a similar such property, and you should choose to use CHOOSE instead.

Just to highlight the point earlier about optimisation, the Fibonacci lambda function may be improved upon too – again, at the risk of mathematical 
/ formulaic comprehension:

=LAMBDA(n, LET(Fibonacci_Faster, LAMBDA(ME, x, F_1, F, current, IF(x <= 2, 1, IF(x = current, F,

 ME(ME, x, F, F_1 + F, current + 1)

))),

Fibonacci_Faster(Fibonacci_Faster, n, 1, 1, 2)))

Now you have something to study the next time you are stranded on a desert island.
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Playing with new functions is highly addictive and can lead you to using 
them when they are not needed.  No matter how optimised recursive 
calculations are, I strongly advise that if you don’t need them, don’t use 
them.  Formulaic alternatives, such as COMBIN for Pascal’s Triangle are 
instant and simple, to the naked eye.

Furthermore, do note that the current operand stack limit in Excel is 
1,024.  This should be borne in mind together with calculation times, as 
the current recursion limit is set as 1,024 divided by (number of lambda 
parameters + 1).

Finally, some common problems faced in financial modelling are not 
recursive in nature, so try not to confuse the issue unnecessarily.  For 
example, the most common financial modelling illustration is the 
calculation of interest on an average cash balance.  This is actually an 
instance of solving two simultaneous equations.  Applying recursive logic 
would be inappropriate.

Step 1: Create a Dynamic Range Name using a formula

Word to the Wise

Suggested Solution

The challenge presented earlier in this newsletter was to generate the list of the five most recent items using Excel formulae.

Of course, we used an example.  There was an Order_Database data set which contained details of Customer Name, Order Date and Order Volume 
over the time, viz.

To facilitate the conversation with customers upon placing an order, the operator wants to view the five most recent orders from that customer.  
Specifically, when a customer is selected from the list in cell H2 (see image above), their last five order dates will appear in cells G6:G10 in descending 
order, together with the corresponding order volumes.  

The challenge was simple: could you get the list in cells G6:G10 in just two steps? 

Navigate to the Formulas tab on the Ribbon and select ‘Define Name’.  In the ‘New Name’ dialog, the List_Order_Date range name should be created 
using the formula below:

=SORT(UNIQUE(FILTER(Order_Database[Order Date],Order_Database[Customer Name]='January 2021'!$H$2)),,-1)

Beat the Boredom Suggested Solution

More Excel Functions next month.
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Yes, we are using the dynamic array formulae to make it work, so we understand this is a solution for Office 365.  However, we should avail ourselves 
of all the features available in modernExcel. 

Let’s break the formula into digestible pieces to understand how it works:

	 •	 the FILTER function will get the list of all dates related to the customer selected in cell H2
	 •	 a customer may make multiple orders in a day, so the UNIQUE function will return no duplicates in the list of dates
	 •	 therefore, the SORT function will arrange this list based upon descending order (as seeing the most recent order first probably makes the 	

most sense).

Given the List_Order_Date, the cells G6:G10 may be filled using the INDEX function.  In case the list of historical order date related to the customer 
is less than five (5), the formula should return a blank, viz.

=IFERROR(INDEX(List_Order_Date,F6),"")

Hence, the order volume can be calculated using the SUMIFS function:

=SUMIFS(Order_Database[Order Volume], Order_Database[Customer Name], $H$2, Order_Database[Order Date], G6)

Until next time.

Step 2: Get the list of last five order dates using the INDEX function

 

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties.  To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course.

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.
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Location Course Date Date Duration Duration

Online (Australia) Power Pivot, Power Query and Power BI 12 - 14 Apr 2023 09:00-17:00 AEST (-1 day) 23:00-17:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 19 Apr 2023 09:00-17:00 AEST (-1 day) 23:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 20 - 21 Apr 2023 09:00-17:00 AEST (-1 day) 23:00-17:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 10 - 12 May 2023 09:00-17:00 AEST (-1 day) 23:00-17:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 17 May 2023 09:00-17:00 AEST (-1 day) 23:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 18 - 19 May 2023 09:00-17:00 AEST (-1 day) 23:00-17:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 7 - 9 Jun 2023 09:00-17:00 AEST (-1 day) 23:00-17:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 14 Jun 2023 09:00-17:00 AEST (-1 day) 23:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 15 - 16 Jun 2023 09:00-17:00 AEST (-1 day) 23:00-17:00 GMT 2 Days
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, we look at the CTRL 
and ALT keys:
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Keystroke What it does
CTRL + SHIFT + 0 Show column

CTRL + SHIFT + 1 Fixed decimal and comma format

CTRL + SHIFT + 2 Time (AM/PM) format

CTRL + SHIFT + 3 Date format

CTRL + SHIFT + 4 Currency format

CTRL + SHIFT + 5 Percentage format

CTRL + SHIFT + 6 Exponential format

CTRL + SHIFT + 7 Outline border

CTRL + SHIFT + 8 Select current region

CTRL + SHIFT + 9 Unhide row

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.
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